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Preface 
 

The undergraduate real-time control laboratory of the Mechanical, Aerospace, and 
Manufacturing (MAM) Engineering Department and this laboratory manual have been 
projects in progress for at least the last three years. Specifically, immediately after my 
arrival to Polytechnic in Fall 1996, I began developing a real-time control laboratory for 
graduate research and teaching. The financial support from the Dean’s Office, the MAM 
department, NASA/NY Space Grant Consortium, ASHRAE, etc., proved extremely 
crucial for the success of this effort. In addition, it exposed my graduate students to the 
modern concepts of DSP and PC-based real-time control, automated C-code generation, 
etc. Having successfully developed the graduate real-time control laboratory, I took the 
next natural step towards the modernization of the undergraduate control laboratory. 
Once again, the Dean’s Office and the MAM department provided the financial resources 
for the new effort. Additional support came from the National Science Foundation-
Division of Undergraduate Education, in Summer 1999, as an equipment grant for the 
laboratory development.  

 
The new undergraduate real-time control laboratory has completely revised and 

modernized the previous control laboratory curriculum and tools. The focus of the new 
laboratory is to provide the undergraduate students hands-on experience in state-of the-art 
PC-based control. It exposes the students to concepts such as client-server environment, 
rapid prototyping, virtual instrumentation, automated code generation, etc. The newly 
developed lab facilities consist of Windows NT workstations, Quanser-MultiQ real-time 
controller boards, experimental test-beds, e.g., servomotor control, magnetic levitation, 
level control in coupled water tanks, rotary inverted pendulum, etc. The laboratory 
continues to be upgraded to expose the students to multidisciplinary aspects of control. 
The on-going laboratory development effort will add process control modules (e.g., level, 
flow, pressure, temperature, and pH control), robotic workcells, hybrid fuel cells, etc. 

 
I sincerely acknowledge Profs. A. Tzes and M. S. de Queiroz for providing 

valuable advice, cooperation, and support for my efforts towards the modernization and 
development of our new undergraduate real-time control laboratory. In addition, I wish to 
acknowledge the efforts of my students Haizhou Pan, Hong Wong, and Qiguo Yan who 
have developed the various laboratory modules described in this laboratory manual. They 
also developed the draft versions of the various sections of this laboratory manual. I also 
wish to acknowledge the support of suppliers of DSP and PC boards, equipment, and 
instrumentation, namely ECP, dSPACE Inc., Feedback Control, and Quanser Consulting. 
Finally, I thank my loving wife Ruchika for her support and patience during this project. 



Laboratory Experiments 
 
 

 
S. No. Title Page No. 

   

1. Introduction to PC-Based Data Acquisition and Real-Time Control 1.1-1.7 

   

2. System Identification and Control of an Electrical Network 2.1-2.9 

   

3. Modeling, Identification, and Control of a DC-Servomotor 3.1-3.11 

   

4. Modeling and Control of a Magnetic Levitation System 4.1-4.13 

   

5. Modeling and Linear Quadratic Control of a Rotary Inverted 

Pendulum 

5.1-5.14 

   

6. Level Control of a Coupled Water Tank 6.1-6.10 

 

 



Experiment 1: Introduction to PC-Based

Data Acquisition and Real-Time Control

Tools/concepts emphasized: Matlab, Simulink, Real-Time-Workshop (RTW), WinCon,

MultiQ-3, data acquisition, and real-time control.

1. Introduction

All real-world applications of feedback control involve

i) mathematical modeling of physical plants;

ii) system/parameter identi¯cation;

iii) feedback control design;

iv) o®-line computer simulation to evaluate closed-loop system performance;

v) real-time feedback control implementation using analog/digital hardware; and

vi) on-line controller adjustment to optimize closed-loop system performance.

You have been familiarized with steps i), iii), and iv) in Automated Control{ME 322. In the

Control Laboratory{ME 325, we will reiterate some aspects of steps i), iii), and iv), as required;

however, our primary focus will be on steps ii), v), and vi).

Traditionally, control systems have been designed and analyzed using analog methods such as

the Laplace transform. In addition, until 1960's, a vast majority of industrial control systems

were implemented using analog technology based on mechanics (e.g., moving bars, linkages, etc.),

pneumatics, and electronics (e.g., resistors, capacitors, op-amps, etc.). However, with the advent

of digital computer technology, control engineering has witnessed a signi¯cant shift towards digi-

tal implementation of feedback controllers [1]. In contrast to analog implementation of feedback

control, digital implementation o®ers small size and low cost. Furthermore, digital controllers are

inherently °exible since they can be changed by reprogramming, whereas analog controllers are

changed by extensive rewiring [1].

In many current industrial and commercial applications of feedback control such as machine

tools, robotics, automotive system, etc., micro-controllers are extensively used. Micro-controllers
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are typically programmed either in low-level machine language or in high-level languages such

as C via PC interfaces. The programming of micro-controllers for implementing advanced control

algorithms is a specialized task and requires trained personnel. However, in the last decade, with the

advent of the fourth generation computer programming tools such as the computer-aided software

engineering (CASE), it has become feasible to automatically generate C code from graphical control-

system simulation tools such as Simulink. In particular, using the Simulink block library and RTW

along with vendor-speci¯c block libraries, one can generate C code from Simulink-based feedback

control diagrams for real-time controller implementation on PC and DSP-based data acquisition

and control boards (DACB).

In the ¯rst laboratory exercise, we will focus on gaining familiarity with the MultiQ-3 DACB [2]

and Matlab, Simulink, RTW, and WinCon [3] software. The MultiQ-3 DACB provides the following

functionalities: analog to digital conversion (ADC), digital to analog conversion (DAC), digital I/O,

and encoder readout. A Simulink compatible block library of MultiQ-3 functions is provided on

each laboratory PC. The WinCon software provides a user friendly graphical user interface (GUI)

for implementing Simulink-based real-time control on MultiQ-3 DACB. In addition, WinCon can be

used to display real-time experimental data on PC. In this experiment, students will learn the basic

functionalities of MultiQ-3 DACB, WinCon, and Simulink automated code generation features by

implementing a simple loop-back example.

2. Background

In this section, we provide a brief overview of the hardware and software environment to be

used throughout this laboratory course.

MultiQ-3 DACB: The MultiQ-3 is a general purpose DACB. It provides 8 single-ended ADCs,

8 DACs, 16 bits of digital inputs, 16 bits of digital outputs, 3 programmable timers, and upto 8

encoder inputs. The MultiQ-3 DACB is accessed through the PC bus and is installed on an ISA

bus internal to the laboratory PC. The aforementioned functions of the MultiQ-3 DACB can be

accessed via an external terminal board.

Matlab-Simulink-RTW: This is the preferred software environment for the control labora-

tory. Students enrolled in this laboratory course were familiarized with the Matlab software in

ME 322. Simulink is a graphical control-system simulation program. The RTW tool-box enables
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automated C code generation from user-designed Simulink control-system diagrams.

WinLib: This is a library of Quanser-supplied DACB drivers (e.g., MultiQ-3) compatible with

Simulink (See Figure 1). Some commonly used blocks of MultiQ-3 (MQ3) library are analog input

(ADC), analog output (DAC), encoder input, and time-base (See Figure 2).

Figure 1: WinLib Block Library

Figure 2: MultiQ-3 Drivers' Block Library

WinCon: The WinCon program interfaces the Simulink generated C code with the MultiQ-3

board in a seamless manner. In addition, it provides useful features for plotting real-time data and

for designing GUI-based controls for on-the-°y controller tuning. The WinCon program consists of

two principal components, viz., WinCon client and WinCon server. The WinCon client is installed

on the host computer with the MultiQ-3 DACB. The WinCon server may be installed on the host

or the remote computer. The user designs a Simulink control diagram and generates the C code on

the remote computer. The C code from the remote computer is transferred to the host computer
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by the WinCon server. The WinCon client and host computer's processor communicate with the

MultiQ-3 DACB for real-time data acquisition and control. The WinCon client also relays the

real-time data to the WinCon server for plotting purposes.

3. Objective

i) Gain familiarity with various functions of the MultiQ-3 board.

ii) Learn the laboratory software environment consisting of Matlab, Simulink, RTW, WinLib,

and WinCon.

iii) Design and implement a simple loop-back control system.

4. Equipment List

i) PC with MultiQ-3 DACB and terminal board

ii) Software environment: Windows, Matlab, Simulink, RTW, and WinCon

iii) Set of leads

5. Experimental Procedure

In this experiment, we will design a controller that outputs a user speci¯ed voltage to a selected

DAC channel and measures the incoming voltage at a selected ADC channel.

i) Using the MultiQ-3 terminal board and a double-ended RCA connector, connect the chan-

nel 0 of DAC (analog output) to channel 0 of ADC (analog input), as illustrated in Figure

3.

ii) From the Start button of the Windows toolbar, select the option sequence Programs{

Matlab{Matlab to launch the Matlab application.

iii) In the Matlab window, at the command prompt, type \Experiment1" and hit the Enter

key. This Matlab script will change the directory from the default Matlab directory to

the working directory for Experiment 1.
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Figure 3: Wiring Diagram for the Loop-Back Experiment

iv) In the Matlab window, at the command prompt, type Simulink and hit the Enter key.

Next, in the Matlab window, type WinLib and hit the Enter key. The preceding two

commands open the Simulink and the MultiQ-3 DACB drivers libraries, respectively.

v) From the Simulink tool bar, select File{Open to open \Template.mdl" ¯le. The ¯le

\Template.mdl" is a blank Simulink model. This ¯le has been created with a set of

RTW options that enable C code generation for Visual C++, RTX (a real-time kernel

for Windows NT), and MultiQ-3 environment. You can determine the selected RTW-

speci¯c parameters by following the option sequence Tools{RTW Options. Please do

not change any of the parameters while doing this.

vi) From the MultiQ-3 series icon in the WinLib library, select and drag the icons labelled

ADC analog input, DAC analog output, and Time-Base, into the blank \Template.mdl"

model ¯le. In addition, from the Simulink block library, under the icons Sources, Sinks,

and Connections, select and drag the icons labelled Constant, Scope, and Terminator,

respectively, into the \Template.mdl" model ¯le. Using the copied icons, complete a

Simulink block-diagram as shown in Figure 4. Next, set the value of the constant under

the icon constant to 1, to output 1 volt at the DAC. In addition, set the channel numbers

under the icons ADC and DAC to 0. Finally, save the completed Simulink control-system

diagram as \Experiment1.mdl."

vii) From the toolbar of \Experiment1.mdl" ¯le, select the option sequence Tools{RTW

Build to link, compile, and generate the C++ code for the Simulink diagram. After the
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Figure 4: Simulink Block-Diagram for the Loop-Back Experiment

completion of C++ code generation process, WinCon server application is automatically

launched.

viii) From the toolbar of WinCon Server window, select the option sequence Plot{New{

Digital Meter. This will launch a digital meter window along with a dialog-box for

selecting a variable to display. Select the variable \Scope" from the list of given variables

to display the input at the ADC.

ix) You can now perform the loop-back experiment. However, before proceeding, you must

request your laboratory teaching assistant to approve your electrical connections and your

Simulink control-system diagram.

x) In the WinCon Server window, click the green Start button to acquire the real-time

data for the loop-back experiment. You can change the output voltage at the DAC by

changing the value of constant in the constant icon. Try experimenting, without exceeding

the constant value by 5 volts.

xi) After su±cient experimentation, press the red Stop button in the WinCon Server window

to stop execution of your program on the MultiQ-3 DACB.

xii) Explore and document various menu options available in the WinCon Server program.
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6. Analysis/Assignment

i) In step x) of Section 5, what is the value of the scope variable, displayed in the digital

meter, when you change the constant voltage applied at the DAC from 1 volt to 4 volt?

Explain.

ii) Based on the loop-back experiment, develop a Simulink control-system diagram to run a

diagnostic test on the 8 DAC and 8 ADC channels available on the MultiQ-3 DACB.

iii) Brie°y explain the principle of operation of ADC and DAC.

iv) What is the purpose of the Time-Base driver in the MQ3 block library?

References

1. K. J. ºAstrÄom and B. Wittenmark Computer-Controlled Systems: Theory and Design,

Prentice-Hall, Upper Saddle River, NJ, 1997, 3rd Ed.

2. MultiQ-3 Programming Manual, Quanser Consulting Inc.

3. WinCon User's Manual, Quanser Consulting Inc.
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Experiment 2: System Identi¯cation

and Control of an Electrical Network

Concepts emphasized: Passive ¯lters, dynamic modeling, time-domain analysis, system type,

and integral control.

1. Introduction

Physical measurements using electro-mechanical sensors are commonly performed by engineers.

For example, a potentiometer can be used for position measurement of machine-bed traverse in

lathe, milling machine, etc. Similarly, a thermocouple can be used for temperature measurement

in process plants. Unfortunately, a vast majority of measurement sensors output spurious noise

signals corrupting the measured quantities [1]. Electrical networks are often designed to ¯lter the

undesired noise from the sensor measurement. One such ¯lter is the passive, low-pass R-C ¯lter

shown in Figure 1 [1]. This laboratory exercise is designed to provide the students fundamental

principles of electrical network modeling, system identi¯cation, and closed-loop control. Speci¯cally,

the ¯rst part of this laboratory experiment exposes the students to the powerful techniques of

ordinary di®erential equations and the Laplace transform for mathematical modeling of real-world

dynamical systems [2,3]. Next, the students learn to analyze the system time response to determine

the unknown physical parameters of the system [2,3]. Finally, the students design a feedback control

system to manipulate the system characteristic such that the closed-loop system response follows

a desired speci¯cation [2, 3].

Figure 1: An R-C Filter Network
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2. Background

Resistor: The voltage-current law governing a linear resistor is given by [1,3]

R =
V

i
; (2.1)

where i is the current °ow through the resistor R when a voltage V is applied across the terminals

of R. A resistor element is conventionally drawn as shown in Figure 2. Units: V (Volt{V), i

(Ampere{Amp), R (Ohm{−=V/Amp).

Figure 2: Diagrammatic Representation of a Resistor Element

Capacitor: A capacitor is constructed by introducing a nonconducting medium within the

gap between two conductors. A capacitor can accumulate electric charge and can thus be used as

an energy storage device (analogous to a spring in a mechanical system). The mathematical law

governing the operation of a capacitor is given by [1, 3]

C =
q

V
; (2.2)

where q is the amount of electric charge stored in the capacitor when a voltage V is applied across

the terminals of C. Note that since

i =
dq

dt
; (2.3)

using (2.2), Eq. (2.3) yields

i = C
dV

dt
: (2.4)

A capacitor element is conventionally drawn as shown in Figure 3. Units: q (Coulomb), V (Volt{V),

C (Farad = Coulomb/Volt).
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Figure 3: Diagrammatic Representation of a Capacitor Element

Kirchho®'s Current Law: The Kirchho®'s current law states that the algebraic sum of all

currents entering and leaving a node is zero [1, 3]. Thus, in Figure 4 at node A

i1 + i2 ¡ i3 = 0; (2.5)

which can be rewritten as

i3 = i1 + i2: (2.6)

Figure 4: Current Flow at a Node

Step Response Analysis of a First-Order System: Consider the transfer function of a

¯rst-order system given by

Y (s)

U(s)
=

®

s+ ¯
: (2.7)

The step response of (2.7) can be obtained by computing the inverse Laplace transform of

Y (s) =
®

s+ ¯
£ A
s
; (2.8)
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where A
s is the Laplace transform of the step input of magnitude A applied at time t = 0. Next,

the inverse Laplace transform of (2.8) yields

y(t) =
A®

¯

h
1¡ e¡¯t

i
: (2.9)

A typical unit step (A = 1) response plot for a ¯rst-order system is shown in Figure 5. Note that

(2.9) can be used to compute the steady-state response of (2.7) for the step input A. Alternatively,

the ¯nal value theorem can be applied to (2.8) to obtain the steady-state response of (2.7) for the

step input A [2, 3].
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Figure 5: Unit Step Response of 1
s+2

System Identi¯cation from Step Response: Consider the special case of (2.7) where ®¯ = D

and D is known. In this case (2.9) can be rewritten as

y(t) = DA
h
1¡ e¡¯t

i
: (2.10)

The goal is to use (2.10) and the experimental step response data to determine the unknown system

parameter ¯. By simple algebraic manipulation of (2.10), we obtain

¯ = ¡1
t
£ ln

·
DA¡ y(t)
DA

¸
: (2.11)

Next, with the known D and the magnitude of the step input A and by selecting a speci¯c time

instance t¤, within the transient response region, and the corresponding y(t¤) from the experimental

data, Eq. (2.11) can be used to determine ¯.
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3. Objective

i) Modeling of the passive R-C network shown in Figure 1.

ii) Open-loop step response analysis for system identi¯cation.

iii) Integral control design for zero steady-state error response.

4. Equipment List

i) PC with MultiQ-3 data acquisition card and connecting board

ii) Software environment: Windows, Matlab, Simulink, RTW, and WinCon

iii) Two resistors of 100 K−

iv) One capacitor of unknown capacitance value

v) Set of leads and a breadboard

5. Experimental Procedure

i) Using the breadboard, set of leads, 100 K − resistors, and the capacitor of unknown

capacitance, construct the electric network shown in Figure 6.

Figure 6: Wiring Diagram for the R-C Filter Network

ii) Start Matlab using the procedure described in laboratory Experiment 1. In addition,

from the Start button of the Windows toolbar, select the option sequence Programs{
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WinCon3{W95Server to launch the WinCon Server application. Next, in the Matlab

window, at the command prompt, type \Experiment2" and hit the Enter key. This

Matlab script will change the directory from the default Matlab directory to the directory

where all ¯les needed to perform Experiment 2 are stored.

iii) From the File menu of WinCon Server, select the option Open to load the experiment ¯le

\Experiment2a.wcp." This will load the ¯les for Experiment 2 (open-loop) and the plot

window shown in Figure 7 will appear on your desktop. Next, from theWindow menu of

WinCon Server, select the option Simulink. This will load the Simulink block-diagram

\Experiment2a.mdl" shown in Figure 8 to your desktop.

Figure 7: WinCon Plot Window for the Open-Loop Step Response of the R-C Network

iv) You can now perform an open-loop analysis of the electrical network shown in Figure

1. However, before proceeding, you must request your laboratory teaching assistant to

approve your electrical connections.

v) In the WinCon Server interface, click the green Start button to acquire the open-loop step

response of the R-C electrical network. The experiment stops after 0.5 second.

vi) From the File menu of the plot window, save the plot data in \Exp2DataA.m". Plot the

open-loop step response from the Matlab window by executing Exp2DataA.
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Figure 8: Simulink Block-Diagram for the Open-Loop Step Response of the R-C Network

vii) Close the currently open plot windows and the Simulink diagram. From the File menu of

WinCon Server, select the option Open to load the experiment ¯le \Experiment2b.wcp."

This will load the ¯les for experiment 2 (closed-loop) and a plot window similar to the

one shown in Figure 7 will appear on your desktop. Next, from the Window menu of

WinCon Server, select the option Simulink. This will load the Simulink block-diagram

\Experiment2b.mdl" shown in Figure 9 to your desktop. Note that the feedback intercon-

nection of the R-C circuit and the Simulink controller in Figure 9 (ignoring the saturation

block) can be represented as shown in the closed-loop feedback diagram of Figure 10.

viii) In the WinCon Server interface, click the green Start button to acquire the closed-loop

step response of the R-C electrical network. The experiment stops after 20 seconds.

ix) From the File menu of the plot window, save the plot data in \Exp2DataB.m". Plot the

closed-loop step response from the Matlab window by executing Exp2DataB.

6. Analysis

i) Obtain the di®erential equation governing the response of the R-C circuit shown in Figure

1. In addition, determine the transfer function that maps the input voltage VIN to the

output voltage VOUT; i.e., determine the transfer function
VOUT(s)
VIN(s)

.
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Figure 9: Simulink Block-Diagram for the Integral Control of the R-C Network

Figure 10: Closed-Loop Feedback Diagram of the R-C Network with Integral Controller

ii) Analyze the open-loop step response obtained in step vi) of Section 5 to a) determine the

unknown capacitance value for the capacitor and b) determine the steady-state error for

the applied step input. For part a), note that the connecting board of the MultiQ-3 data

acquisition card introduces a capacitor of 1 ¹F in parallel to the unknown capacitor C

in Figure 1. You must write a function .m ¯le which accepts VIN, R, t, and VOUT(t), as

input arguments and returns the unknown capacitance value as the output.

iii) Obtain the step response of the R-C network using Simulink. Compare the simulated

response with the actual response and comment.
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iii) Analyze the closed-loop step response obtained in step ix) of Section 5 to determine the

steady-state error for the step input.

iv) Design a proportional-plus-integral controller
³
Kp +

Ki
s

´
so that the step response of the

closed-loop system has less than 5% overshoot and the settling time Ts · 0:3 seconds.

Simulate the closed-loop system step response using Simulink.

References

1. W. Bolton Mechatronics: Electronic Control Systems in Mechanical and Electrical Engineer-

ing, Addison Wesley, New York, NY, 1999.

2. R. C. Dorf and R. H. Bishop Modern Control Systems, Addison Wesley, Menlo Park, CA,

1998.

3. K. Ogata Modern Control Engineering, Prentice-Hall, Upper Saddle River, NJ, 1997.

2-9



Experiment 3: Modeling, Identi¯cation,

and Control of a DC-Servomotor

Concepts emphasized: Dynamic modeling, time-domain analysis, system identi¯cation, and

position-plus-velocity feedback control.

1. Introduction

DC-motors that are used in feedback controlled devices are called DC-servomotors [1{4]. Appli-

cations of DC-servomotors abound, e.g., in robotics, computer disk drives, printers, aircraft °ight

control systems, machine tools, °exible manufacturing systems, automatic steering control, etc.

DC-motors are classi¯ed as armature controlled DC-motors and ¯eld controlled DC-motors [4].

This laboratory experiment will focus on the modeling, identi¯cation, and position control of an

armature controlled DC-servomotor. In particular, we will ¯rst develop the governing di®erential

equations and the Laplace domain transfer function model of an armature controlled DC-motor.

Next, we will focus on the identi¯cation of the unknown system parameters that appear in the

transfer function model of the DC-servomotor. Finally, we will develop and implement a position-

plus-velocity, also known as proportional-plus-derivative (PD), feedback controller to ensure that

the DC-motor angular position response tracks a step command.

2. Background

DC-motor modeling: A schematic representation of an armature controlled DC-motor is

given in Figure 1. For an armature controlled DC-motor, the ¯eld current if is constant and the

torque Tm generated at the DC-motor shaft is given by [2{4]

Tm = KTia; (2.1)

where KT is the given motor torque constant (N-m/Amp) and ia is the armature current (Amp).

Note that for an armature controlled DC-motor, the back e.m.f. induced in the armature due

to armature rotation is directly proportional to the armature angular velocity !m(t)
4
=
dµm
dt where

µm(t) is the angular position of the motor shaft. Thus, following [2{4]

Vb = Kb

dµm
dt
; (2.2)
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where Kb is a given motor constant (Volt-sec/rad).

Figure 1: Armature Controlled DC-Motor

Next, note that the angular speed !m(t) of an armature controlled DC-motor is controlled by

the armature voltage Va. The di®erential equation relating the armature current ia and the back

e.m.f. Vb to the armature voltage Va can be obtained by applying Kirchho®'s Voltage Law [1, 4].

In particular, according to the Kirchho®'s Voltage Law, at any given instant of time, the algebraic

sum of voltages around any loop in any electric network is zero. Thus, a direct application of the

Kirchho®'s Voltage Law to the armature circuit yields

La
dia
dt
+Raia + Vb = Va: (2.3)

Finally, we obtain the di®erential equation governing the motion of the mechanical load. First,

note that in most applications, the DC-servomotor shaft is connected to a gear-box of a given

gear-ratio Kg and the load is attached to the output shaft of the gear-box (e.g., see Figure 2). The

gear-ratio Kg is give by Kg
4
=

n`
nm
, where n` and nm are the number of teeth on the load-side and

the motor-side gears, respectively. It can be easily shown that the gear-ratio Kg relates the motor

shaft angular position µm to the gear-box output shaft angular position µ` by Kg =
µm
µ`
. In addition,

it can be shown that the load inertia J` acting at the output shaft of the gear-box when re°ected

at the motor shaft is given by 1
K2
g
J`. Thus, an application of Newton's moment balance equation

at the motor output shaft yields

Jm
d2µm
dt2

+
1

K2
g

J`
d2µm
dt2

+
1

K2
g

bt
dµm
dt

= Tm;
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which can be rewritten as

Jeq
d2µ`
dt2

+ bt
dµ`
dt

= KgTm; (2.4)

where Jeq = K
2
gJm+ J` is the total load inertia re°ected at the motor shaft and bt is the rotational

viscous friction constant.

Figure 2: DC-Motor Experiment Test-Bed

Now, taking the Laplace transform of (2.1){(2.4) and after some algebraic manipulations to

eliminate the variables Tm, Vb, and ia , we obtain

µ`(s)

Va(s)
=

KgKT

s
³
LaJeqs2 + (Labt +RaJeq)s+Rabt +K2

gKTKb

´ : (2.5)

In addition, the transfer function from input Va to output !` is given by

!`(s)

Va(s)
=

KgKT

LaJeqs2 + (Labt +RaJeq)s+Rabt +K2
gKTKb

: (2.6)

Now, assuming two real, simple roots of the characteristic equation of (2.6), viz., pe and pm, partial

fraction expansion of (2.6) yields

!`(s)

Va(s)
=

Ke

s+ pe
+

Km

s+ pm
: (2.7)

Next, using the inverse Laplace transform, the forced response of the system (with zero initial

condition) to the input Va(t) is given by

!`(t) =

Z t

0

h
Kee

¡pe(t¡q) +Kme
¡pm(t¡q)

i
Va(q)dq: (2.8)

In most practical applications of armature controlled DC-motors, pe >> pm; i.e., the electrical

subsystem responds considerably faster than the mechanical subsystem. Hence, the ¯rst exponential
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term in (2.8) decays rapidly. Thus, the response !`(t) in (2.8) is dominated by the mechanical

subsystem Km
s+pm

. For simplicity, in DC-servomotor control applications the in°uence of the electrical

subsystem component ( Kes+pe
) on the response !`(t) in (2.8) is commonly neglected [2{4]. This can

alternatively be viewed as neglecting the armature inductance e®ect, La. This simpli¯cation yields

a ¯rst-order transfer function model which relates the DC-motor load angular velocity response !`

to the armature voltage input Va, and is given by

!`(s)

Va(s)
=

KgKT

RaJeqs+Rabt +K2
gKTKb

: (2.9)

Before proceeding, note that, it can be shown that in the SI-Units used for KT and Kb, the

numerical values of KT and Kb are identical [3]. Finally, the transfer function model of (2.9) can

be equivalently written as

!`(s)

Va(s)
=

K

¿s+ 1
; (2.10)

whereK and ¿ are the dc-gain and the mechanical time-constant of the DC servomotor, respectively.

3. Objective

i) Analysis of DC-motor sensor characteristics.

ii) DC-motor system identi¯cation.

iii) PD control of the DC-motor to achieve the desired angular position step response charac-

teristics.

4. Equipment List

i) PC with MultiQ-3 data acquisition card and connecting board

ii) Software environment: Windows, Matlab, Simulink, RTW, and WinCon

iii) SRV-02 DC-motor apparatus (See Figure 3) with potentiometer, optical encoder, and

tachometer

iv) Universal power module: UPM-1503

v) Set of leads
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Figure 3: SRV-02 DC-Motor Apparatus

5. Experimental Procedure

i) Using the set of leads, universal power module, SRV-02 DC-motor apparatus, and the

connecting board of the MultiQ-3 data acquisition card, complete the wiring diagram

shown in Figure 4.

ii) Start Matlab and WinCon Server. In the Matlab window, at the command prompt, type

\Experiment3" and hit the Enter key. This Matlab script will change the directory from

the default Matlab directory to the directory where all ¯les needed to perform Experiment

3 are stored.

iii) You can now perform various steps of the DC-motor identi¯cation and control experiment.

However, before proceeding, you must request your laboratory teaching assistant to che-

ck your electrical connections.

iv) From the File menu of the WinCon Server, select the option Open to load the exper-

iment ¯le \Experiment3 Pot.wcp." This will load the ¯les for determining the gain of
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Figure 4: Wiring Diagram for DC-Motor ID and Control

the potentiometer Kpot (
radian
Volt

). A digital meter window will also appear on your desk-

top. The potentiometer gain Kpot relates the potentiometer output voltage Vpot to the

load angular displacement µ` by µ` = KpotVpot. Next, from the Window menu of the

WinCon Server, select the option Simulink. This will load the Simulink block-diagram

\Experiment3 Pot.mdl" shown in Figure 5 to your desktop.

a) In the WinCon Server interface, click the green Start button to acquire the poten-

tiometer voltage response.

b) Rotate the load connected to the output shaft (center gear) until the potentiometer

voltage in the digital meter window shows 0 Volt. Please ensure that you get contin-

uous variation in the neighborhood of this 0 Volt reading. If you note a discontinuity

in the reading, turn the load by 180± and this will provide you close to 0 Volt reading.

Read the angular position µ±0 of the load, corresponding to the 0 Volt potentiometer

reading, o® the protractor marked on the SRV-02 apparatus.
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Figure 5: Simulink Block-Diagram for Determining Potentiometer Gain

c) Rotate the load to µ0+90
± and note the corresponding potentiometer voltage reading

in the digital meter window.

d) Rotate the load to µ0¡90± and note the corresponding potentiometer voltage reading
in the digital meter window.

e) In the WinCon Server interface, click the red Stop button when you ¯nish collecting

the potentiometer voltage response data.

v) Close the currently open digital meter window and the Simulink diagram. From the File

menu of the WinCon Server, select the option Open to load the experiment ¯le \Experi-

ment3 Tach.wcp." This will load the ¯les for determining the gain of the tachometer Ktach

( radian
second-Volt

) and a plot window. The tachometer gain Ktach relates the tachometer output

voltage Vtach to the load angular velocity !` by !` = KtachVtach. Next, from theWindow

menu of the WinCon Server, select the option Simulink which loads the Simulink ¯le

\Experiment3 Tach.mdl" shown in Figure 6 to your desktop.

a) In the WinCon Server interface, click the green Start button. This applies a constant

1 Volt input to the DC-motor.

b) Measure the steady-state load angular speed and the corresponding steady-state

tachometer output voltage reading in the plot window. Hint: Find the time re-
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Figure 6: Simulink Block-Diagram for Determining Tachometer Gain

quired for 20 complete revolutions of the load and the corresponding steady-state

tachometer output voltage reading at the end of 20 revolutions.

c) In the WinCon Server interface, click the red Stop button when you ¯nish collecting

the tachometer voltage response data.

vi) Close the currently open plot windows and the Simulink diagram. From the File menu

of the WinCon Server, select the option Open to load the experiment ¯le \Experi-

ment3 DCID.wcp." Next, from the Window menu of the WinCon Server, select the

option Simulink which loads the Simulink ¯le \Experiment3 DCID.mdl" shown in Fig-

ure 7 to your desktop. In this diagram, the gain Ktach must be supplied by you. Run

this part of the experiment to acquire the transient and steady-state angular velocity step

response of the DC-motor under load.

vii) Close the currently open plot windows and the Simulink diagram. From the File menu

of the WinCon Server, select the option Open to load the experiment ¯le \Experi-

ment3 PDCont.wcp." Next, from the Window menu of the WinCon Server, select the

option Simulink which loads the Simulink ¯le \Experiment3 PDCont.mdl" shown in Fig-

ure 8 to your desktop. In this diagram, the gains Kpot and Ktach must be supplied by you.

In addition, the gains KP and KD must be designed and supplied by you. In particular,

design a PD feedback controller so that the DC-motor angular position step response ex-
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Figure 7: Simulink Block-Diagram for DC-Servomotor System Identi¯cation

hibits a peak overshootMp · 5% with settling time Ts · 1 second. The feedback diagram
of the DC-motor with the PD feedback controller is shown in Figure 9. The characteristic

equation of the closed-loop system in Figure 9 can be used for the purpose of ¯nding KP

and KD such that the desired performance speci¯cations are achieved. Before proceeding,

you must request your laboratory teaching assistant to approve your gain values. Run

the experiment to record the angular position step response of the DC-motor.

6. Analysis

i) Calculate Kpot andKtach from the experimental data collected in steps iv) and v) of Section

5.

ii) Analyze the open-loop angular velocity step response obtained in step vi) of Section 5

to determine the dc-gain K and the mechanical time constant ¿ of the DC-servomotor

system.

iii) Obtain the angular velocity step response of the ¯rst-order system (2.10) with the param-

eters K and ¿ obtained in step ii) above. Compare the simulated angular velocity step

response with the experimental response obtained in step vi) of Section 5 and comment.

3-9



Figure 8: Simulink Block-Diagram for DC-Servomotor PD Control

Figure 9: Closed-Loop Feedback Interconnection for PD Control of a DC-Motor

iv) Analyze the closed-loop angular position step response obtained in step vii) of Section 5

to determine if the performance speci¯cations are satis¯ed. Comment on your results.

v) Design a proportional-integral-derivative (PID) controller so that the performance require-

ments speci¯ed in Section 5 are satis¯ed. Simulate the closed-loop angular position step

response with the PID controller. Compare with the experimental closed-loop angular

position step response obtained using the PD controller.
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Experiment 4: Modeling and Control

of a Magnetic Levitation System

Concepts emphasized: Dynamic modeling, time-domain analysis, PI and PID feedback con-

trol.

1. Introduction

Magnetic levitation is becoming widely applicable in magnetic bearings, high-speed ground

transportation, vibration isolation, etc., [1]. For example, magnetic bearings support radial and

thrust loads in rotating machinery. In addition, magnetic suspension generates levitation action in

rectilinear motion devices such as high-speed ground transportation systems. Magnetic levitation is

immensely bene¯cial in the aforementioned rotary and rectilinear devices as it yields a non-contact

support, without lubrication, thus eliminating friction. All practical magnetic levitation systems

are inherently open-loop unstable and rely on feedback control for producing the desired levitation

action.

The \maglev" experiment is a magnetic ball suspension system which is used to levitate a steel

ball in air by the electromagnetic force generated by an electromagnet. The maglev system consists

of an electromagnet, a ball rest, a ball position sensor, and a steel ball. The maglev system is

completely encased in a rectangular enclosure divided into three distinct vertical chambers. The

upper chamber houses an electromagnet such that one pole of the electromagnet is exposed to the

middle chamber and faces a black post erect in the middle chamber. The post is designed such that

with a 2.54 cm steel ball at rest on its surface, the top of the ball surface is 14 mm from the face of

the electromagnet. The middle chamber is illuminated using a light bulb. The ball elevation from

the top face of the post is measured using a sensor embedded in the post. The bottom chamber

houses sensor circuitry for signal conditioning.

The objective of the experiment is to design a controller that levitates the steel ball from the

post and makes it track a speci¯ed position trajectory. The maglev system can be decomposed

into two subsystems, viz., a mechanical subsystem and an electrical subsystem (current loop). The

ball position in the mechanical subsystem can be controlled by adjusting the current through the

electromagnet whereas the current through the electromagnet in the electrical subsystem can be

controlled by applying controlled voltage across the electromagnet terminals. Thus, the voltage
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applied across the electromagnet terminals provides an indirect control of the ball position.

In this laboratory exercise, we will ¯rst develop the governing di®erential equation and the

Laplace domain transfer function models of the electrical and mechanical subsystems. Next, we

will design and implement a proportional-integral (PI) controller to guarantee that the electrical

subsystem current response tracks the speci¯ed current command. Finally, we will design and im-

plement a proportional-integral-derivative (PID) controller to ensure that the mechanical subsystem

ball position response tracks the desired position command.

2. Background

Electrical Subsystem Modeling: A schematic representation of the maglev ideal electrical

subsystem is given in Figure 1. The electromagnet coil has an inductance L (Henry) and a resistance

R` (Ohm). The voltage V applied to the coil results in a current i governed by the di®erential

equation [3]

V = iR` + L
di

dt
: (2.1)

Figure 1: Ideal Electrical System

In order to determine the current in the coil, the mglev actual electrical subsystem (see Figure

2) is equipped with a resistor Rs in series with the coil such that the voltage Vs across Rs can

be measured using an A/D converter. Now, the voltage Vs measured across Rs can be used to

compute the current i in the coil. Note that with the sensing resistor Rs in the circuit the governing

di®erential equation for the coil current becomes

V = i (R` +Rs) + L
di

dt
: (2.2)
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Figure 2: Actual Electrical System

Finally, taking the Laplace transform of (2.2), we obtain

Ge (s)
4
=

I(s)

V (s)
=

1

Ls+ (R` +Rs)
; (2.3)

where I(s) 4= L[i(t)] and V (s) 4= L[V (t)] and L is the Laplace operator.
Mechanical Subsystem Modeling: The force experienced by the ball under the in°uence of

electromagnet is given by [2,3]

F = mg ¡Kf

µ
i

x

¶2
; (2.4)

where i is the current in electromagnet (Ampere), x is the distance of the ball from the electro-

magnet face (mm), g is the gravitational constant (mmsec2 ), Kf is the magnetic force constant for the

electromagnet-ball pair, and m is the mass of the steel ball (Kg). Using Newton's second law, we

now obtain the di®erential equation governing the ball position as

m
d2x

dt2
= mg ¡Kf

µ
i

x

¶2
: (2.5)

Note that using (2.5), we can compute the steady-state electromagnet coil current iss that

produces the desired steady-state constant ball position xss. Speci¯cally, setting
d2x
dt2

= 0 in (2.5)

yields

iss =

r
mg

Kf

xss: (2.6)

Now, theoretically one can use (2.6) to regulate the ball position. However, external disturbances,

system parameter uncertainty/variation, etc., necessitate a feedback controller to improve the me-

chanical subsystem performance.
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Next, de¯ning a set of shifted variables

x̂(t) 4
= x(t)¡ xss; (2.7)

î(t) 4
= i(t)¡ iss; (2.8)

we can rewrite the dynamic equation (2.5), as

m
d2x̂

dt2
= mg ¡Kf

Ã
î+ iss
x̂+ xss

!2
: (2.9)

Now, linearizing (2.9) about (x̂ = 0; î = 0), yields [3]

d2x̂

dt2
=

1

m

24 @

@x̂

Ã
mg ¡Kf

(̂i+ iss)
2

(x̂+ xss)2

!¯̄̄̄
¯
(x̂=0;̂i=0)

x̂+
@

@î

Ã
mg ¡Kf

(̂i+ iss)
2

(x̂+ xss)2

!¯̄̄̄
¯
(x̂=0;̂i=0)

î

35 ; (2.10)
or, equivalently,

d2x̂

dt2
=
2Kfi

2
ss

x3ssm
x̂¡ 2Kfiss

x2ssm
î: (2.11)

Finally, taking the Laplace transform of (2.11), we obtain

Gm (s)
4
=

X̂(s)

Î(s)
= ¡ a

s2 ¡ b ; (2.12)

where X̂(s) 4= L[x̂(t)], Î(s) 4= L[̂i(t)], and

a 4
=

2Kfiss
x2ssm

; b 4=
2Kfi

2
ss

x3ssm
: (2.13)

The numerical values of the electrical and mechanical subsystem parameters for the laboratory

maglev model are provided in Table 1 below. In addition, the variables a and b in (2.13) are

computed with xss = 7 mm and iss = 1 Amp.

3. Objective

i) PI control of the electrical subsystem to track a desired current.

ii) PID control of the mechanical subsystem to track a desired ball position.
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Physical quantity Symbol Numerical value Units

Coil inductance L 0.4125 Henry

Coil resistance R` 10 Ohm

Current sensor resistance Rs 1 Ohm

Force constant Kf 32654 mN-mm2

Amp2

Gravitational constant g 9810 mm
sec2

Ball mass m 0.068 Kg

Table 1: Numerical Values for Physical Parameters of The Maglev System

4. Equipment List

i) PC with MultiQ-3 data acquisition card and connecting board

ii) Software environment: Windows, Matlab, Simulink, RTW, and WinCon

iii) Magnetic levitation apparatus with a steel ball

iv) Universal power module: UPM-2405

v) Set of leads

5. Experimental Procedure

i) Using the set of leads, universal power module, magnetic levitation apparatus, and the

connecting board of the MultiQ-3 data acquisition card, complete the wiring diagram

shown in Figure 3.

ii) Start Matlab and WinCon Server. In the Matlab window, at the command prompt, type

\Experiment4" and hit the Enter key. This Matlab script will change the directory from

the default Matlab directory to the directory where all ¯les needed to perform Experiment

4 are stored.

iii) You can now perform various steps of the magnetic levitation control experiment. However,

before proceeding, you must request your laboratory teaching assistant to check your

electrical connections.

iv) From the File menu of the WinCon Server, select the option Open to load the experiment

¯le \Experiment4 A.wcp." This will load the ¯les for calibrating the ball sensor voltage
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Figure 3: Wiring Diagram for The Maglev Experiment

when the ball is resting on the black post. The voltage measured on S1 should be about 0

Volts. A digital meter window will also appear on your desktop. Next, from theWindow

menu of the WinCon Server, select the option Simulink. This will load the Simulink

block diagram \Experiment4 A.mdl" shown in Figure 4 to your desktop.

a) In the WinCon Server interface, click the green Start button to acquire the voltage

measured on S1 (position sensor).

b) Adjust the o®set potentiometer on the Maglev to obtain 0 Volts.

c) In the WinCon Server interface, click the red Stop button when you ¯nish calibrating

the sensor o®-set.

v) Close the currently opened digital meter window and the Simulink diagram. From the

File menu of the WinCon Server, select the option Open to load the experiment ¯le

\Experiment4 B.wcp." This program applies 1.5 Amperes to the coil which causes the

ball to jump up to the magnet and stay there. The voltage measured on S1 should be
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between 4.75 and 4.95 Volts. A digital meter window will appear on your desktop.

Next, from theWindow menu of the WinCon Server, select the option Simulink. This

will load the Simulink block-diagram \Experiment4 B.mdl" shown in Figure 5 to your

desktop.

a) In the WinCon Server interface, click the green Start button to acquire the

voltage measured on S1 (position sensor).

Figure 4: Simulink Block-Diagram for Ball Position Sensor O®set Calibration

Figure 5: Simulink Block-Diagram for Ball Position Gain Calibration
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b) Adjust the gain potentiometer on the Maglev to obtain anywhere between 4.75

to 4.95 Volts on the position sensor.

c) In the WinCon Server interface, click the red Stop button when you ¯nish cali-

brating the sensor gain.

vi) Close the currently opened plot windows and the Simulink diagram. From the File

menu of the WinCon Server, select the option Open to load the experiment ¯le \Experi-

ment4 C.wcp." A plot window will also appear on your desktop. Next, from theWindow

menu of the WinCon Server, select the option Simulink which loads the Simulink ¯le \Ex-

periment4 C.mdl" shown in Figure 6 to your desktop. The various Simulink subblocks

used in Figure 6 are given in detail in Figures 7{11.

a) In Figure 6, under the subblock labeled Current Control (Figure 10), the gains

Kp and Ki must be designed and supplied by you. In particular, design a PI

feedback controller so that the two poles of the close-loop electrical subsystem are

-270 and -0.8 respectively. The feedback diagram of the electrical subsystem with

the PI controller is shown in Figure 12, where A 4
= R` + Rs. The characteristic

equation of the closed-loop system in Figure 12 can be used for the purpose of

¯nding Kp and Ki such that the desired poles are achieved.

b) In Figure 6, under the subblock labeled Mechanical control (Figure 11), the

gains Kp, Ki, and Kd must also be designed and supplied by you. In particular,

design a PID feedback controller so that the ball position step response exhibits

a peak overshoot Mp · 5% with settling time Ts · 0:19 seconds. The close-loop
system is a third order system; hence you must set the third pole to the left of the

dominant complex-conjugate pole-pair. The feedback diagram of the mechanical

subsystem with the PID controller is shown in Figure 13. The characteristic

equation of the closed-loop system in Figure 13 can be used for the purpose

of ¯nding Kp, Ki, and Kd such that the desired performance speci¯cations are

achieved. Note that in Figure 9, a feedforward controller based on (2.6) is also

included to account for the iss term in (2.6).
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Figure 6: Simulink Block-Diagram for Magnetic Levitation System PID Controller

c) Before proceeding, you must request your laboratory teaching assistant to ap-

prove your gain values. In the WinCon Server interface, click the green Start

button to acquire the transient and steady-state position step response of the

ball.

6. Analysis

i) What is the signi¯cance of steps iv) and v) of Section 5 where we adjust the o®set and

gain potentiometers, respectively, to achieve the desired voltage from the position sensor?

ii) Evaluate the actual overshoot and setting time of the ball position step response and

compare with the speci¯ed overshoot and setting time. Comment.

iii) How will the electrical subsystem (See Figure 12) respond if gains Kp and Ki are selected

to set the two poles of the electrical subsystem at -1 and -0.8?
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iv) Can we experimentally set the real root of the closed-loop mechanical subsystem very far

from the imaginary axis, in the left-half plane?

Figure 7: Calibration Subblock

Figure 8: Command Subblock
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Figure 9: Sensor Delay Removal Subblock

Figure 10: Current Control Subblock
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Figure 11: Mechanical Control Subblock

Figure 12: Closed-Loop Feedback Interconnection for PI Control of Electrical Subsystem
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Figure 13: Closed-Loop Feedback Interconnection for PID Control of Mechanical Subsystem
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Experiment 5: Modeling and Linear Quadratic

Control of a Rotary Inverted Pendulum

Concepts emphasized: Dynamic modeling, linearization, state variables, and LQR design.

1. Introduction

The problem of balancing a broomstick in a vertical upright position on a person's hand (see

Figure 1) is well known to the feedback control community [1, 4]. For any human, a physical

demonstration of the broomstick-balancing act constitutes a challenging task requiring intelligent,

coordinated hand movement based on visual feedback. The instability associated with the equilib-

rium point (® = 0; _® = 0), corresponding to the broomstick vertical upright position, leads to the

challenge inherent in the problem.

Figure 1: The Broomstick Balancing Problem [1]

A one-dimensional (1{D) electro-mechanical analogue of the broomstick-balancing problem is

the classical inverted-pendulum-on-cart (IPC) problem [1] (see Figure 2). In the IPC problem, the

cart is moved rectilinearly to keep the pendulum vertical upright. The IPC problem is intimately

related to the problem of balancing a missile immediately after launch [1,4].

The dynamics of IPC are inherently nonlinear. In addition, similar to the broomstick-balancing

problem, the equilibrium point (® = 0; _® = 0) for the inverted pendulum is unstable. The feedback

control design problem for IPC has been extensively studied and a variety of control designs have
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Figure 2: Inverted Pendulum on Cart Problem

been proposed in the literature for this interesting problem. In this laboratory exercise, we will

consider a variant of the IPC problem, viz., the 1{D rotary inverted pendulum (RIP) problem.

The laboratory RIP-model consists of a rigid link (pendulum) rotating in the vertical plane.

The rigid link is attached to a pivot arm which is mounted on the load shaft of the SRV-02 DC-

motor. The pivot arm can be rotated in the horizontal plane by the SRV-02 DC-motor. The SRV-02

DC-motor is instrumented with an encoder and a tachometer. In addition, an encoder is mounted

on the pivot arm to measure the pendulum angle. The principal objective of this experiment is

to balance the pendulum in the vertical upright position and to position the pivot arm. Since the

plant has two degrees of freedom but only one actuator, the system is underactuated and exhibits

signi¯cant nonlinear behavior for large pendulum excursion.

In this laboratory exercise, we will develop the governing di®erential equations of motion for the

RIP-system using Lagrange's method [3]. Next, we will linearize the nonlinear RIP-model dynamics

in the neighborhood of interest and develop a state-space model for the system. In addition, we will

brie°y outline the Linear Quadratic Regulator (LQR) design methodology [5]. For step command

tracking, we will unify the integral control scheme with the LQR control design technique [2].

Finally, we will design, implement, and evaluate the performance of an LQ tracking control law on

the laboratory RIP test-bed.
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2. Background

Mechanical system modeling: A schematic representation of the rotary inverted pendulum

is given in Figure 3 where lp denotes the pendulum helf-length and mp denotes the pendulum mass.

Assume that the pendulum rod is rigid and massless. Let ® be the angle of the rod from the vertical

axis z. The pivot arm OA has length r. The total e®ective mass moment of inertia re°ected at the

output shaft of the SRV-02 DC-motor apparatus is called the base mass moment of inertia and is

denoted by Jb. Note that Jb includes moment of inertia of DC-motor, tachometer, various gears,

and pivot arm; all re°ected at the center of rotation O. The SRV-02 DC-motor applies a torque ¿

on the pivot arm OA.

Figure 3: Simpli¯ed Model of Rotary Inverted Pendulum

Next, note that the position vector OB in the cylindrical coordinate frame er{eµ{ez is given by

¡!
OB = rer + lp sin® eµ + lp cos® ez: (2.1)

Furthermore, note that the coordinate frame er{eµ{ez has angular velocity _µez. Next, computing
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d
dt

¡!
OB, the velocity of mass mp (or point B) is given by

¡!v = ¡lp _µ sin® er + (r _µ + lp _® cos®)eµ ¡ lp _® sin® ez: (2.2)

Now, it follows from (2.2) and the notation v 4
= j¡!v j that

v2 = (lp _µ sin®)
2 + (r _µ + lp _® cos®)

2 + (lp _® sin®)
2: (2.3)

Next, note that the total kinetic energy of the RIP-system is the sum of kinetic energies of the

pendulum mass mp and the base inertia Jb, which are given by

Tp =
1

2
mpv

2; (2.4)

and

Tb =
1

2
Jb _µ

2; (2.5)

respectively. Thus, the total kinetic energy of the RIP-system is

T =
1

2
(mpv

2 + Jb _µ
2): (2.6)

Furthermore, the potential energy of the RIP-system is given by

U = mpglp cos®; (2.7)

where g is the gravitational acceleration. Finally, note that computing the work done by the

external torque ¿ (applied by the SRV-02 DC-motor)

±W = ¿±µ;

the generalized forces are identi¯ed to be

Qµ = ¿; Q® = 0: (2.8)

Now, we use Lagrange's equations [3] for µ and ® coordinates given by

d

dt

µ
@T

@ _µ

¶
¡ @T
@µ

+
@U

@µ
= Qµ; (2.9)

and

d

dt

µ
@T

@ _®

¶
¡ @T
@®

+
@U

@®
= Q®; (2.10)
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to obtain

(mpr
2 + Jb +mpl

2
p sin

2 ®)Äµ + (mprlp cos®)Ä®¡ (mprlp sin®) _®
2 + (2mpl

2
p sin® cos®) _®

_µ = ¿; (2.11)

and

mpl
2
pÄ®+ (mprlp cos®)Äµ ¡ (mpl

2
p sin® cos®)

_µ2 ¡mpglp sin® = 0; (2.12)

respectively.

Next, we simplify the dynamic model (2.11), (2.12) by linearizing it in the vicinity of the

equilibrium point (® = 0; _® = 0), which corresponds to the pendulum maintaining a vertical

upright position. Thus, in (2.11), (2.12), we replace sin® ¼ ® and cos® ¼ 1 and neglect the

higher-order terms in the variables ®, _®, etc. This leads to the linearized RIP-system dynamics

(mpr
2 + Jb)Äµ +mprlpÄ® = ¿; (2.13)

mpl
2
pÄ®+mprlpÄµ ¡mpglp® = 0: (2.14)

After simple algebraic manipulation of (2.13), (2.14), we obtain the following linear, state-space

representation [5] of the RIP-system26664
_µ
_®
Äµ
Ä®

37775 =
266664
0 0 1 0
0 0 0 1
0 ¡mprg

Jb
0 0

0
Jb+mpr

2

lpJb
g 0 0

377775
26664
µ
®
_µ
_®

37775+
26664

0
0
1
Jb

¡ r
lpJb

37775 ¿: (2.15)

DC-motor dynamics: Recall from Experiment 3 that, neglecting the armature inductance

La, equations (2.2) and (2.3) of Experiment 3 yield

Va = iaRa +Kb!m

= iaRa +KbKg!`; (2.16)

since !m = Kg!` where !`
4
=
_µ is the load (i.e., the pivot arm) angular velocity. Now, it follows

from (2.16) that

ia =
Va
Ra

¡ KbKg

Ra
!`: (2.17)

Next, using ¿ = KgTm and equation (2.1) of Experiment 3, it follows that

¿ = KgKTia: (2.18)
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Hence, using (2.17) in (2.18), and noting that in the SI-units the numerical values of KT and Kb

are identical [4], we obtain

¿ =
KbKg

Ra
Va ¡

K2
bK

2
g

Ra
!`: (2.19)

The numerical values of the mechanical and electrical subsystem parameters for the laboratory

RIP-model are provided in Table 1 below.

Physical quantity Symbol Numerical value Units

Pivot arm length r 8:75£ 0:0254 meter

Base mass moment of inertia Jb 0.005 Kg-meter2

Pendulum length 2lp 13:125£ 0:0254 meter

Pendulum mass mp 0.126 Kg

Gravitational constant g 9.8 meter=sec2

DC-motor armature resistance Ra 2.6 Ohm

Motor constant KT;Kb 0.00767 N-m/Amp, Volt-sec/rad

Gear ratio Kg 14£ 5
Table 1: Numerical Values for Physical Parameters of The RIP-System

Finally, substituting (2.19) into (2.15), rearranging terms, and using the numerical parameter

values given in Table 1, we obtain the RIP-system model given by26664
_µ
_®
Äµ
Ä®

37775 =
26664
0 0 1 0
0 0 0 1
0 ¡55:0710 ¡22:2484 0
0 132:2206 29:6645 0

37775
26664
µ
®
_µ
_®

37775+
26664

0
0

41:4385
¡55:2514

37775Va: (2.20)

3. LQR-Based Controller Design

Linear quadratic regulator theory: The LQR theory is a powerful method for the control of

linear systems in the state-space domain. The LQR technique generates controllers with guaranteed

closed-loop stability robustness property even in the face of certain gain and phase variation at

the plant input/output. In addition, the LQR-based controllers provide reliable closed-loop system

performance despite the presence of stochastic plant disturbance. The LQ control design framework

is applicable to the class of stabilizable linear systems.

Next, we brie°y summarize the LQR theory. Given an nth-order stabilizable system

_x(t) = Ax(t) +Bu(t); t ¸ 0; x(0) = x0; (3.1)
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where x(t) 2 Rn is the state vector and u(t) 2 Rm is the input vector, determine the matrix gain

K 2 Rm£n such that the static, full-state feedback control law

u(t) = ¡Kx(t); (3.2)

satis¯es the following criteria:

i) the closed-loop system (3.1) and (3.2) is asymptotically stable and

ii) the quadratic performance functional

J(K) 4
=

Z 1

0
[xT (t)R1x(t) + u

T (t)R2u(t)]dt; (3.3)

where R1 is a nonnegative-de¯nite matrix that penalizes the departure of system states

from the equilibrium and R2 is a positive-de¯nite matrix that penalizes the control input,

is minimized.

The solution of the LQR problem can be obtained via a Lagrange multiplier-based optimization

technique and is given by

K = R2
¡1BTP; (3.4)

where P 2 Rn£n is a nonnegative-de¯nite matrix satisfying the matrix Riccati equation

0 = ATP + PA+R1 ¡ PBR2¡1BTP: (3.5)

Note that it follows from (3.2) that the LQR-based control design requires the availability of

all state variables for feedback purpose. The state variables for the laboratory RIP-system model

are identi¯ed from (2.20) to be µ, ®, _µ and _®. For our laboratory RIP-model, the pivot arm

angle µ and angular velocity _µ are measured by an encoder and a tachometer, respectively. The

pendulum angular position ® is measured by another encoder. The pendulum angular velocity _®

is not measured by any physical sensor, instead, we numerically compute _® by implementing a

low-pass di®erentiator, e.g. 100s
s+100 , as part of the overall control scheme.

In order to design an LQR controller for the RIP-system, we identify the plant dynamics A and

input matrix B from (2.20). In addition, we choose the weighting matrices R1 and R2 to penalize
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the state and control variables, respectively, as

R1 =

26664
0:25 0 0 0
0 4 0 0
0 0 0 0
0 0 0 1

37775 ; R2 = 0:2: (3.6)

Note that in (3.6), R1 places a signi¯cantly higher penalty on the pendulum angle ® excursions

(R1(2; 2) = 4) than the pivot arm angle µ excursions (R1(1; 1) = 0:25). In addition, the pendulum

angular velocity _® is penalized (R1(4; 4) = 1) whereas the pivot arm angular velocity _µ is not

penalized at all (R1(3; 3) = 0). This R1 prevents large departure of pendulum angle ® from

the equilibrium and the tendency of the pendulum to fall down; thus maintaining the pendulum

equilibrium (® = 0; _® = 0). The control penalty R2 given in (3.6) is determined by trial and error.

A larger value for R2 will lead to smaller control e®ort and larger excursions of µ and ® whereas a

smaller value of R2 will lead to larger control e®ort which may saturate the actuator.

Next, an LQR controller for the given data is designed by using the Matlab command lqr to

solve the matrix Riccati equation (3.5) and to compute the controller gain (3.4). In particular,

executing K = lqr(A;B;R1; R2), in the Matlab command window (with the input variables in the

Matlab memory) we obtain the feedback regulator gain

K =
h
¡1:1180 ¡19:7995 ¡1:6190 ¡3:2299

i
V/rad;

=
h
¡0:0195 ¡0:3460 ¡0:0283 ¡0:0565

i
V/deg: (3.7)

Finally, the controlled voltage to be applied to the SRV-02 DC-motor is given by

Va(t) = ¡0:0195µ(t)¡ 0:3460®(t)¡ 0:0283 _µ(t)¡ 0:0565 _®(t): (3.8)

LQR-based tracking controller design: The LQR-based control law (3.8) renders the origin

of the RIP-system asymptotically stable, i.e., lim
t!1x(t)! 0 with (3.8). Thus, although the above

controller maintains the pendulum in the vertical upright position, it does not allow one to position

the pivot arm arbitrarily. An LQR-based controller can be designed to position the pivot arm at a

nonzero angle by shifting the origin of the state variable µ to the desired set point of the pivot arm

angular position. However, external disturbances and nonlinear e®ects, e.g., gravity, gear backlash,

etc., present in the RIP-model may lead to poor closed-loop system performance for LQR-based

set point controllers. Next, recall from the classical control theory that the integral control action
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yields zero steady-state error for constant command input tracking even in the presence of exogenous

disturbances. Thus, in this experiment, to design a tracking controller which positions the pivot

arm as well as maintains the pendulum vertical upright, we unify the integral control scheme with

the LQR design methodology.

Hence, consider the feedback diagram shown in Figure 4 where the integrator 1
s has been

introduced to enable the pivot arm to track constant command angle. Note, that the integral state

xI satis¯es

_xI = e; (3.9)

where

e 4
= µ ¡ r: (3.10)

Note that in (3.10) r is the desired, constant pivot arm angular position. In addition, it follows

from (3.10) that

_e = _µ: (3.11)

Now, replacing the _µ equation in the vector di®erential equation (2.20) by (3.11) and augmenting

the resulting vector di®erential equation with (3.9), we obtain the state-space model2666664
_e
_®
Äµ
Ä®
_xI

3777775 =
2666664
0 0 1 0 0
0 0 0 1 0
0 ¡55:0710 ¡22:2484 0 0
0 132:2206 29:6645 0 0
1 0 0 0 0

3777775

2666664
e
®
_µ
_®
xI

3777775+
2666664

0
0

41:4385
¡55:2514

0

3777775Va: (3.12)

Next, we select the following design variables for the LQR-based tracker design

R1a =

2666664
0:25 0 0 0 0
0 4 0 0 0
0 0 0 0 0
0 0 0 0 0
0 0 0 0 0:04

3777775 ; R2a = 0:05: (3.13)

Now, using the augmented system dynamic matrix Aa and input matrix Ba from (3.12) and the

weighting matrices R1a and R2a from (3.13), we can design the augmented feedback control gain

Ka by executing the Matlab command Ka = lqr(Aa; Ba; R1a; R2a). Finally, the feedback gains K

and KI implemented in Figure 4 are obtained from
h
K KI

i
= Ka.
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Figure 4: Integral Control of Rotary Inverted Pendulum

4. Objective

i) Develop and linearize the governing di®erential equations of the RIP-system.

ii) Design and implement a stabilizing LQR-based controller for the laboratory RIP-model.

iii) Design and implement an LQ-based tracker for the laboratory RIP-model.

5. Equipment List

i) PC with MultiQ-3 data acquisition card and connecting board

ii) Software environment: Windows, Matlab, Simulink, RTW, and WinCon

iii) SRV-02 geared DC-motor apparatus with an optical encoder and tachometer; pivot arm

attachment with an encoder; and pendulum

iv) Universal power module: UPM-1503

v) Set of leads

6. Experimental Procedure

i) Using the set of leads, universal power module UPM 1503, SRV-02 DC-motor apparatus,

and the connecting board of the MultiQ-3 data acquisition card, complete the wiring

diagram shown in Figure 5.
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Figure 5: the Wiring Diagram for Rotary inverted Pendulum

ii) Start Matlab and WinCon Server. In the Matlab window, at the command prompt, type

\Experiment5" and hit the Enter key. This Matlab script will change the directory from

the default Matlab directory to the directory where all ¯les needed to perform Experiment

5 are stored.

iii) You can now perform various steps of the rotary inverted pendulum experiment. However,

before proceeding, you must request your laboratory teaching assistant to check your elec-

trical connections.

iv) At the Matlab command prompt, execute the script Experiment5a. This will assign the

numerical values of the physical parameters of the RIP-model, compute the linear state-

space model (2.20), assign the penalty matrices R1 and R2 of (3.6), and solve the LQR
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problem to generate the controller gain (3.7). Note that for this part of the experiment

the integral control gain KI is set to zero.

v) From the File menu of the WinCon Server, select the option Open to load the experiment

¯le Experiment5.wcp. This will load the ¯les for conducting the RIP stabilization

experiment.

a) From theWindow menu ofWinCon Server, select the option Simulink which

loads the Simulink ¯le \Experiment5.mdl" as shown in Figure 6 to your desktop.

Figure 6: Simulink Block-Diagram for LQR-Based RIP Stabilization

b) In order to properly start the controller, move the pivot arm to the zero position

and hold the pendulum in the vertical upright position when you click the green

Start button.

c) Record the time response of the pendulum angle alpha and the pivot arm angular

position theta.

d) Apply a slight tap to the pendulum so that it falls around 2.5 degrees which
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causes the arm to move toward the falling direction. Record the time response

of pendulum angle ® and pivot arm angular position µ.

e) Note that the LQR controller (3.7) implemented in this part of the experiment

does not include the integral control action. To evaluate the pivot arm tracking

performance of controller (3.8), change the value of the constant block in the

Simulink block-diagram of Figure 6 and record the time response of pendulum

angle ® and pivot arm angular position µ.

vi) To design the LQR-based tracker outlined in Section 3, execute the script Experiment5b

at the Matlab command prompt. This will produce the augmented system dynamics and

input matrices, the augmented state and control penalty matrices, and the controller gain

Ka along with its partitions K and KI. Next, repeat steps v.a){v.e) given above.

7. Analysis/Assignment

i) In Section 2, we developed the nonlinear RIP-system dynamic model (2.11), (2.12) by

approximating the pendulum as a point mass concentrated at the pendulum center of

gravity. In addition, in Section 2, the point mass mp is assumed to be attached to a

massless rigid bar of length lp. The preceding assumptions essentially ignore the rotational

e®ects of pendulum mass moment of inertia on system dynamics. Develop a complete

nonlinear RIP-system model which accounts for the rotational e®ects of the pendulum

mass moment of inertia.

ii) Analyze the scripts \Experiment5a.m" and \Experiment5b.m."

iii) Analyze and comment on your experimental results. In addition, contrast the performance

of the stabilizing control law with the tracking control law.

iv) Analyze the e®ects of the Control Filter and Tach Filter blocks in the Simulink block-

diagram of Figure 6.

v) Identify the nonlinearities present in the laboratory RIP-system and discuss their e®ects

on the system response.
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Experiment 6: Level Control of a Coupled Water Tank

Concepts emphasized: Dynamic modeling, time-domain analysis, and proportional-plus-

integral control.

1. Introduction

Industrial applications of liquid level control abound, e.g., in food processing, beverage, dairy,

¯ltration, e²uent treatment, and nuclear power generation plants; pharmaceutical industries; water

puri¯cation systems; industrial chemical processing and spray coating; boilers; and automatic liquid

dispensing and replenishment devices. The typical actuators used in liquid level control systems

include pumps, motorized valves, on-o® valves, etc. In addition, level sensors such as displacement

°oat, capacitance probe, pressure sensor [1], etc. provide liquid level measurement for feedback

control purpose. In this laboratory exercise, the students model, calibrate, and control a two-

tank level control system. In particular, this experiment exposes the students to the fundamental

modeling principle of °uid mass balance, pressure sensor calibration, and a feedback control design

methodology for a state-coupled, two-tank level control system.

2. Background

System Modeling: The schematic drawing in Figure 1 represents the model of a two degree-

of-freedom (DOF) state-coupled, water tank system. This system consists of two tanks with ori¯ces

and level sensors at the bottom of each tank, a pump, and a water basin. The two tanks have same

diameters and can be ¯tted with di®erent diameter out°ow ori¯ces. In this laboratory setup, the

pump provides infeed to Tank 1 and the out°ow of Tank 1 becomes infeed to Tank 2. The out°ow

of Tank 2 is emptied into the water basin. The following conditions with regard to the system

dynamic model are used to describe the level of water in Tanks 1 and 2.

i) The water levels in Tanks 1 and 2 are measured by two pressure sensors;

ii) the level of water in Tank 1 is always less than 30 cm;

iii) the desired level of water in Tank 2 is always greater than 0 cm and less than 20 cm;

iv) the voltage applied at the input terminals of the pump is between 0 and 22 Volts.
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Figure 1: State-Coupled Two-Tank System

Based on the above assumptions, the dynamic equations for the liquid level in the two tanks

are derived as follows. Note that for each tank the time rate of change of liquid level is given by

_Li(t) =
1

Ai

¡
F ini (t)¡ F outi (t)

¢ cm

sec
; i = 1; 2; (2.1)

where Li, Ai, F
in
i , and F

out
i are the liquid level, cross-sectional area, in°ow rate, and out°ow rate,

respectively, for the ith tank. Next, note that the in°ow rate to Tank 1 is given by

F in1 (t) = KpVp
cm3

sec
; (2.2)

where Kp is the pump constant (
cm3

Volts-sec
) and Vp is the voltage applied to the pump. In addition,

using Bernoulli's law for °ow through small ori¯ces, the out°ow velocity from the ori¯ce at the

bottom of each tank is

vouti (t) =
p
2gLi

cm

sec
; i = 1; 2: (2.3)

Then, the out°ow rate for each tank is given by

F outi (t) = ai
p
2gLi

cm3

sec
; i = 1; 2; (2.4)

where g is the gravitational acceleration and ai denotes the cross-sectional area of the out°ow ori¯ce

at the bottom of the ith tank. Finally, note that for the two-tank level control system shown in

Figure 1

F in2 (t) = F out1 (t): (2.5)
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Thus, using (2.1){(2.5), we obtain the dynamic equations for the liquid level in the two tanks as

_L1(t) = ¡ a1
A1

q
2gL1(t) +

Kp

A1
Vp(t); (2.6)

_L2(t) =
a1
A2

q
2gL1(t)¡ a2

A2

q
2gL2(t): (2.7)

Remark 2.1. Note that using (2.6), we can compute the steady-state pump voltage Vpss that

produces the desired steady-state constant level L1ss in Tank 1. Speci¯cally, setting _L1(t) = 0 in

(2.6) yields

Vpss = a1

p
2gL1ss
Kp

: (2.8)

In a similar manner, we can compute the steady-state level L1ss in Tank 1 that produces the desired

steady-state constant level L2ss in Tank 2. Speci¯cally, setting _L2(t) = 0 in (2.7) yields

L1ss =

µ
a2
a1

¶2
L2ss : (2.9)

Now, theoretically one can use (2.8), (2.9) to regulate the water level in Tank 2. However, external

disturbances, system parameter uncertainty/variation, etc., necessitate a feedback controller to

improve the level control system performance.

Next, de¯ning a set of shifted variables

`1(t)
4
= L1(t)¡ L1ss ; (2.10)

`2(t)
4
= L2(t)¡ L2ss ; (2.11)

u(t) = Vp(t)¡ Vpss ; (2.12)

we can rewrite the dynamic equations (2.6), (2.7) as

_̀
1(t) = ¡ a1

A1

q
2g(`1(t) + L1ss) +

Kp

A1

¡
u(t) + Vpss

¢
; (2.13)

_̀
2(t) =

a1
A2

q
2g(`1(t) + L1ss)¡

a2
A2

q
2g(`2(t) + L2ss): (2.14)

Finally, linearizing (2.13), (2.14), about (`1 = 0; `2 = 0; u = 0), we obtain

_̀
1(t) = ®1`1(t) + ¯1u(t); (2.15)

_̀
2(t) = ®2`2(t) + ¯2`1(t); (2.16)
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where

®1
4
= ¡ a1

A1

s
g

2L1ss
; ¯1

4
=

Kp

A1
;

®2
4
= ¡ a2

A2

s
g

2L2ss
; ¯2

4
=

a1
A2

s
g

2L1ss
: (2.17)

Next, we address the level control problem for Tank 2 (i.e., set-point tracking of L2(t)) via a

subsystem decomposition of (2.15), (2.16). In particular, we consider the level control for L2 via

the subsystem dynamics (2.16) with `2 and `1 as the subsystem output and input, respectively.

The level control problem for the Tank 2 subsystem necessitates the control of level L1 in Tank 1.

The problem of controlling L1 is addressed via the subsystem dynamics (2.15) with `1 and u as the

subsystem output and input, respectively.

Now, we develop the transfer function models for the subsystem dynamics (2.15) and (2.16).

Thus, taking the Laplace transform of (2.15) and arranging terms, we obtain

G1(s)
4
=

`1(s)

u(s)
=

¯1
s¡ ®1 ; (2.18)

where `1(s)
4
= L[`1(t)] and u(s) 4= L[u(t)] and L is the Laplace operator. Similarly, taking the

Laplace transform of (2.16) and arranging terms, we obtain

G2(s)
4
=

`2(s)

`1(s)
=

¯2
s¡ ®2 ; (2.19)

where `2(s)
4
= L[`2(t)].

The numerical values of the parameters for the laboratory two-tank water level control system

are provided in Table 1 below. Note that the variables ®i and ¯i, for i = 1; 2, in (2.17) are computed

with L1ss = L2ss = 12 cm.

Physical quantity Symbol Numerical value Units

Tank 1, 2 diameters D1; D2 4.425 cm

Tank 1, 2 ori¯ce diameters d1; d2 0.47625 cm

Pump constant Kp 4.6 cm3

Volts-sec

Gravitational constant g 980 cm
sec2

Table 1: Numerical Values for Physical Parameters of Two-Tank Level Control System
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3. Objective

Proportional-plus-integral (PI) control of the state-coupled, two-tank system to track a desired

level of water in Tank 2.

4. Equipment List

i) PC with MultiQ-3 data acquisition card and connecting board

ii) Software environment: Windows, Matlab, Simulink, RTW, and WinCon

iii) Water Tank apparatus with a water basin

iv) Universal power module: UPM-2405

v) Set of leads

5. Experimental Procedure

i) Using the set of leads, universal power module, water tank apparatus, and the connecting

board of the MultiQ-3 data acquisition card, complete the wiring diagram shown in Figure

2.

ii) Start Matlab and WinCon Server. In the Matlab window, at the command prompt, type

\Experiment6" and hit the Enter key. This Matlab script will change the directory from

the default Matlab directory to the directory where all ¯les needed to perform Experiment

6 are stored.

iii) You can now perform various steps for the level control of coupled water tanks. However,

before proceeding, you must request your laboratory teaching assistant to check your

electrical connections.

iv) From the File menu of the WinCon Server, select the option Open to load the experiment

¯le \Experiment6 A.wcp." This will load the ¯les for calibrating the pressure sensor voltage

when there is no water in Tanks 1 and 2. The voltage measured on S1 and S2 should be 0

Volts. A digital meter window will also appear on your desktop. Next, from theWindow
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Figure 2: Wiring Diagram for Two-Tank Level Control

menu of the WinCon Server, select the option Simulink. This will load the Simulink

block diagram \Experiment6 A.mdl" shown in Figure 3 to your desktop.

a) In the WinCon Server interface, click the green Start button to acquire the voltages

measured on S1 (the level of water in Tank 1) and S2 (the level of water in Tank 2).

b) Adjust the o®set potentiometers 1 and 2 on the water tank apparatus back panel

to obtain 0 Volts.

c) In the WinCon Server interface, click the red Stop button when you ¯nish calibrating

the sensor o®-set.
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Figure 3: Simulink Block-Diagram for Water Pressure Sensor O®set and Gain Calibration

v) Fill water into Tank 1 upto the 25 cm level. The voltage measured on S1 should now be

about 4.1 Volts.

a) In the WinCon Server interface, click the green Start button to acquire the

voltage measured on S1 (pressure sensor).

b) Adjust the gain potentiometer 1 on the water tank apparatus back panel to

obtain any where between 4.0 to 4.2 Volts on S1 (pressure sensor).

c) In the WinCon Server interface, click the red Stop button when you ¯nish cali-

brating the sensor gain.

vi) Repeat (v) for Tank 2.

vii) Close the currently opened plot windows and the Simulink diagram. From the File

menu of the WinCon Server, select the option Open to load the experiment ¯le \Experi-

ment6 B.wcp." A plot window will also appear on your desktop. Next, from theWindow

menu of the WinCon Server, select the option Simulink which loads the Simulink ¯le \Ex-

periment6 B.mdl" shown in Figure 4 to your desktop. The various Simulink subblocks

used in Figure 4 are given in detail in Figures 5 and 6.

a) At the Matlab command prompt, execute the script Experiment6. This will as-

sign the numerical values of the physical parameters of the two-tank level control
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Figure 4: Simulink Block-Diagram for Two-Tank System PI Control

system.

b) In Figure 4, under the subblock labeled Tank 1 Controller (Figure 5), the gains

kp1 and ki1 must be designed and supplied by you. In particular, design a PI

controller so that the closed-loop Tank 1 subsystem response exhibits a peak

overshoot less than 1.5% and settling time less than 10 seconds. Note that G1(s)

given by (2.18) denotes the open-loop transfer function for the Tank 1 subsystem.

Furthermore, note that in Figure 4, a feedforward controller based on (2.12) is

also implemented for the Tank 1 subsystem to account for the Vpss term in (2.12).

c) In Figure 4, under the subblock labeled Tank 2 Controller (Figure 6), the gains

kp2 and ki2 must also be designed and supplied by you. In particular, design a

PI controller so that the closed-loop Tank 2 subsystem response exhibits a peak

overshoot less than 3.5% and settling time less than 20 seconds. Note that G2(s)

given by (2.19) denotes the open-loop transfer function for the Tank 2 subsystem.

Furthermore, note that in Figure 4, a feedforward controller based on (2.10) is
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implemented for the Tank 2 subsystem to account for the L1ss term in (2.10).

d) Before proceeding, you must request your laboratory teaching assistant to ap-

prove your gain values. In the WinCon Server interface, click the green Start

button to acquire the transient and steady-state step response of the level of

water in Tank 2.

Figure 5: Tank 1 Controller Subblock

Figure 6: Tank 2 Controller Subblock
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6. Analysis

i) Analyze the script \Experiment6.m" and the simulink control diagram \Experiment6 B.mdl."

ii) Build a nonlinear simulation model (using Simulink) for the two-tank level control system.

Note that as in the laboratory setup, for the simulation model the input voltage to the

pump must be limited to 22 Volts. Obtain the open-loop response of the system. In

addition, obtain the closed-loop response of the simulation model. How does the simulated

system response compare with the experimental response?

iii) Obtain the closed-loop response for the simulation model of the two-tank level control

system with a) only the PI controller and b) only the feedforward controller.

iv) Analyze and comment on your experimental results. Speci¯cally, analyze the experimental

time response of water levels in Tanks 1 and 2. Does the system response meet the

performance speci¯cations? Explain.

v) Obtain the experimental response of the two-tank system to disturbances. Note that

addition of water into Tank 1 and/or Tank 2 from any source other than the pump

constitutes an exogenous disturbance.
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